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Class Schedule:

Currently, these classes are being offered back-to-back. It is suggested that if you have not had any Photoshop experience that you take only Photoshop I, and leave some time for reflection of the material before attending Photoshop II. Because of the large volume of information in these classes, trying to learn everything at once can be challenging. This handout will, however, help by including some information learned in the first class as you continue into the second class.

Objectives: Photoshop II
· Review & Reference Information

· Actions & Batching

· Layers

· Working with Text

· Buttons
· Creating a Webpage in Photoshop
· Saving and Printing

· Vector vs. Bitmap 

· Using the Pen Tool

· Preferences and Settings

· Cool Tools in PS

· Questions? 

Materials:

· Handout

· Ready- to- use images in I:// drive

Please copy the Exercise files onto the desktop of your computer:
1. Click on the Start Menu button the task bar

2. Choose “My Computer” (may be called “AFT##”, your machine name instead)

3. Double-Click the I drive: “I:// Ittc on IT-Dept Server”, then click on the ITD folder

4. Click and drag the “Photoshop” folder onto your desktop

**If you would like to save some of the files we worked on today, please save them to your desktop and we can arrange to save them to disk, or email them to you following today’s class.
Please use this space for additional note taking if needed!
Layout: Tools and Palettes (a quick review)
In order to get comfortable learning and using Photoshop you must first feel comfortable with the layout. Photoshop has several primary components that come up by default to make it easier for you to make modifications. You do not have to keep anything on your layout that you don’t want, but it is a good idea to be educated about what each palette does before closing it.

Below is a screen shot of the basic layout you will see when opening Photoshop. The numbers label each major portion of the screen and are explained below. Please ask if you have questions or if your screen looks different from what appears below.
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1. Toolbox: This displays all the tools that are available. Tools that have more than one option for use (for example, multiple brush shapes or filters) have small arrows in the lower right hand corner. By placing your mouse over the tool button and clicking and holding down the left mouse button, you will see both the selected option and the other possible options.
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	Rectangular Marquee Tool: Allows user to select a section of canvas by clicking and dragging.
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	Move Tool: Move selected section by clicking a dragging.
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	Lasso Tool: Allows user to select an area by moving the cursor around an object. Unlike Rectangular Marquee, the user can select close to the object.
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	Magic Wand Tool: Click on an area and this tool will select all like sections connected to it.
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	Crop Tool: User can click in the corner and select the portion of the photo they want to see. Move edges in or out by clicking on the boxes. Double click in the middle to put into effect.

	[image: image8.bmp]
	Slice Tool: Used to cut images and designs into smaller, separate images. Used for the purposes of creating a web page in conjunction with ImageReady.
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	Healing Brush Tool: Alt- Click on section with colors similar to the section you want to repair. Click and move mouse over sections to cover. They should blend automatically.
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	Paint Brush Tool: Select thickness and color of brush and draw!
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	Clone Stamp/ Pattern Stamp Tool: Alt- Click to pull color from selected area. Unlike ‘Healing Brush’ it will not blend. Pattern tool allows you to draw with a selected pattern.
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	History Brush Tool: Returns image to its original saved state regardless of how long ago changes were made (i.e. do not appear in History palette).
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	Erase Tool: Choose size of eraser and click and drag over sections to remove.
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	Gradient/ Paint Bucket Tool: Select color (or gradient) and apply to selected area
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	The Sharpen, Blur and Smudge tools. Three of the most common filters. Click and hold button down to toggle between tool types.
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	The Dodge, Burn and Sponge tools. These affect the saturation, hue and dispersion of colors. Click and hold button down to toggle between tool types.
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	Path Selection Tool: Use to select vector paths and points for modification
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	Text Tool: Select font and size from choices above. Click where you want to add text, then begin typing
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	Pen Tool: Used to draw vector lines and shapes.
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	Shape Tool: Select your shape. Then click and drag to one side or another to create shape.
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	Notes Tool: This button will insert text notes that can only be seen by someone who open the image in Photoshop.

	[image: image26.bmp]
	Eyedropper Tool: Allows you to select from small areas.
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	Hand Tool: This tool will display the image in ‘Actual Pixels’, ‘Fit On Screen’ or ‘Print Size’ mode.
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	Zoom Tool: another way to view the image. It will zoom into a selected area, increasing the view 100% at each click.
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	Screen Mode- Masks: These will allow you to quickly select an area to be masked in order to make adjustments to the remaining area.
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	Screen Mode- Size: The display button sets Photoshop into Standard Screen Mode, Full screen mode, or the full screen mode with no toolbar.
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	Jump to ImageReady: Click on the ImageReady icon to take current image into ImageReady to be used for web designs.
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	Foreground/Background Color Display: Displays the color selected in foreground position, alternate color to fill background in back position. Set to default (black/white) with the button in the lower left. Switch colors with button in upper right position.


2. Options Bar: This bar, located just below the Menu Bar, gives many more options for the way you use the Tools you select. For example, with the Text Tool, you can adjust size, font and orientation here. With the Pattern Stamp you can use the Options Bar to select your pattern and the size of your brush.

3. This is your image. It is displayed on a canvas which can be enlarged or shrunk to any size needed (this can be done with the zoom tool or the Navigator Palette). 

4. Navigator: This is a palette which displays the size of the image that you are viewing. In this way you can manage the size of the image as you modify it. This is also an easy way to zoom in for detailed work.

5. Color: This is the palette which controls the colors in your foreground and background boxes. You can get specific shades with this tool.

6. History: Displays the 20 previous events that you completed. You can select any of the previous twenty, or go back to the way the picture looked originally. Basically a shortcut for ‘undo’.

7. Layers: Layers are created when you use Tools to add or correct your original image. This palette helps you manage those layers by seeing what is on each, locking them, and displaying or hiding them.

Numbers 4-7 are Palettes. The palettes here are the default palettes and the most commonly used. These palettes can be closed and others opened depending on what you would like to use. A full list of palettes is available in the Windows menu. See below for information on each palette type (not including those listed above) and what it does. 

	Tools
	This will show or hide the main toolbox.

	Options
	This will show or hide the options bar at the top of the Photoshop window. 

	File Browser
	This will open the quick file browser that appears in the upper right hand corner of the Photoshop window.

	Info
	This displays the color size shape and pixel information of the selected area.

	Swatches
	Quick access to 128 primary color choices for quick access. Capability to add to swatches for personal color favorites.

	Styles
	Quick access to 17 basic designs (i.e., color, texture and blending options) to be applied to an object or text.

	Actions
	Ability to choose from 13 preset actions that run filters and processes to apply popular looks and effects to an existing image.

	Tool Presets
	Quick access to 17 preset tool options, such as tool specific settings for brush size, colors, shapes, fonts etc. 

	Channels
	View the color information based on the image mode of the current file.

	Paths
	View the vector paths of the current file; select between various paths.

	Brushes
	This will open the quick brushes option display in the upper right hand corner of the Photoshop window. Choose between different brush styles and sizes.

	Paragraph
	Options for formatting a paragraph of text.

	Characters
	Quick access to font changes, color options, faux facings and other text effects.

	Status Bar
	Hides or displays the status information bar that runs along the bottom of the Photoshop window.


Actions & Batching

In the History palette there is an additional tab for the ‘Actions’ menu. The Actions menu has a series of preset steps for changing an image. When you select one it will complete the steps for you on the selected photo. 

	Since there may be dozens of steps to complete the action, the history menu will place a “snapshot” of your image immediately prior to the action so that you can undo the series of steps that were needed without going through the history menu or undoing.

You can also record your own actions. To do so, click on the ‘Record’ button at the bottom of the Actions palette window. From that point on, everything you do in the Photoshop window will be “recorded” until you choose “Stop”. Once you have completed the steps you would like to record and stopped the recording you can run the action you created on your own photos.
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‘Batch’ is one other option available having to do with Actions. Under File- Automate- Batch, you can select a folder and apply an Action to all the images in the folder. So, if you have an action to resize and color balance each image, you can apply that action to a folder of photos and correct them quickly, easily and uniformly.
Layers

Please open the ‘Photoshop’ folder. Select ‘lines.psd’ and ‘linescanes.psd ’.

We will be using this image to help us practice with the tools discussed below.

When you open an image you usually start with one layer that is either the photo itself or the new file (background). As you add things to the image, layers are added. A good rule of thumb when understanding layers is that modifications do not add layers, but additions to the image do. For example, adding a line, shape or text to an image will add a layer. Changing the color of one of these images will modify the layer, but not create a new one.

Layers can be tricky when it comes to saving and modifying an image. For example, Multi- channel and Index colors will not support layers, so before viewing your image in these modes you will have to Merge or Flatten the image. Also, changes that are made in one layer will not affect the other layers unless you have merged them or have them in a layer set.  
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	Layer Options

The user has several options when working with layers. The buttons at the top of the layer palette allow you to view or hide the layers, determine the selected layer’s transparency and lock the layer, layer position and also the information in the layer. The Layer Menu on the taskbar gives options for creating a new blank layer, layers with colors, gradients, or patterns and layer masks (which are just masks applied to a specific layer rather than the whole image. You can also choose to copy, merge or delete layers.
Layer Set

A layer set groups a series of layers together. You can go to Layers- New- Layer Set to create one, and then drag and drop the layers into the Layer Set. When you have the layer set selected, all changes made to that set will affect the layers within. The blue arrow to the right is to expand and display or hide the layers in the set or the effects applied to that layer. 


The layer options mentioned above and the layer styles discussed below are also applicable to Layer Sets, so any changes made to the set will apply to all layers in that set. If you decide to, you can select a specific layer in a set. This will apply changes to just that one layer.
Layer Styles (aka Blending Options)
This is a series of options available under Layers in the Taskbar; however they can be modified in detail by right clicking on the layer (either on the image or in the Layer palette) and selecting blending options. This allows a long list of adjustments to be made to the layer from adding shading to text, to applying fills and gradients, and adding strokes or textures. This can be very useful in the creation of buttons and other images for the web.
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You can modify the properties of the effects that are added by making choices from the additional options on the right-hand side of the layer styles pop-up window.

Working with Text

Text is one of the best things about Photoshop. Photoshop has hundreds of font options and you should play with them all. These fonts are especially useful for the web since fonts online can be hard to get and difficult to use universally. Text is also much less flexible when written in a web page than when created as an image and inserted. So here are a few things to help.

Blending Options
The Layer Styles that we discussed above can be applied especially well to text. By right clicking and selecting ‘Blending Options’, the user can apply shadows, fading, colors, patterns, and beveling to existing text.

Text for the Web
When you click on the text tool, drag the mouse button rather than clicking on the background. This will display a type bounding box which allows you to set the area and will then constrain paragraph type in this area.

Anti- Aliasing
Anti-aliasing, which can be adjusted by going to Layers- Text, allows greater numbers of colors to be applied to text which in turn, makes it appear more to merge into the background. Without anti- aliasing, your text will be much more sharply defined against the background. Anti- aliasing will limit your ability to save the image as a smaller file, since it will require more color information. It can also be a problem with smaller text because this will make the text appear fuzzy and less defined. Larger text should not have this problem. 

Knockout 

This is a blending option that really works with layers, but is most often used with text. Create a layer with text and under blending options, select ‘Knockout’ dropdown menu. Shallow will knockout to the first possible layer or layer set. Deep will knockout through Layer sets and through to the background. You will have to adjust the ‘Fill’ or ‘Opacity’ for this to display. An example of this tool is below:


Please open the ‘Photoshop’ folder. Select ‘boxbgd.jpg ’.

Use the instructions discussed above to create ‘knockout’ text.

Buttons
This is a nice and simple way to create buttons for the web. If you select the Shape tool from the toolbox, there is an option on the toolbar at the top and far right that has a box with a red line through it. This is a drop- down menu and if you click on the arrow, you will see options for gradients, patterns and color options that can be used to decorate the shape you draw, effectively turning it into a button. 

The option you selected will apply a series of blending options to the appropriate layer. If you decide that you do not want to use a specific style, you can click on the eye on the layer palette to hide the effect. You can also use this to display your button in various phases, essentially creating an appearance for a rollover button. By saving the button several times, each time with different effects toggled on or off, you can create images that can be saved and used with Dreamweaver or other web design applications later.

Creating a Webpage in Photoshop
It is possible to create a webpage in Photoshop. This is done by using Photoshop to draw and arrange shapes, buttons, photos and other elements that would fit on a webpage. 

Once the file looks like you would like your webpage to look, we can begin slicing it into pieces with the slice tool. These pieces are then exported through ImageReady and include the code that is needed to hold the design together and display it properly on the web. 


Please open the Photoshop folder. Select webpage.psd

This file includes a web page design that we are going to use to practice cutting slices with the slice tool. Once the slices are cut we will export the file as an “html” file with images. We can use the “Export As” option in the File menu to choose the file type and quality of the saved images. The exported html file will include all the code needed to keep the image slices we created together, and make the webpage look like the image created in Photoshop.

Please note: We do not plan to spend a great deal of time on this, though it could literally take hours to learn the details of using Photoshop for this purpose. If you would like to learn more about Photoshop’s capacity for creating and exporting webpages, please contact your instructor(s) for one-on-one assistance.
Saving Options
The basic saving option in Photoshop is, like all other applications, ‘Save As…”. This will allow you to save the file in one of dozens of different possible file types including:

	Photoshop (PSD)
	Bitmap (BMP)
	TIFF

	Photoshop (EPS)
	CompuServe GIF
	PNG (Fireworks)

	Photoshop (PDF)
	Jpeg (JPG)
	


The Photoshop options all work with Adobe products. “PSD” is the primary Photoshop file type. “EPS” is an Adobe Illustrator file type and of course, “PDF” is for opening in Adobe Acrobat. 

Bitmaps are the original Windows image format. They are raster images and support only RGB color. They are not supported by web browsers and also do not store detailed information, so they are not good for printed images. They are best used for simple Windows based images. 
GIF’s are a very basic and standard image file format. Like Bitmaps they are limited in what they can save, but unlike bitmaps they are viewable in web browsers. GIF’s may be in RGB or grayscale format but can only store up to 256 colors, which keeps the file size of most GIF’s considerably lower than other formats. GIFs also have the special ability to allow transparency in the image. All this makes them ideal for the web, but again is less viable for printing. 

JPEG’s are the best of both worlds. They can use RGB, CMYK or grayscale colors, and are not limited by the number of colors available. JPEG’s save with an adjustable “lossy compression” approach. This means that if there is a concern about the size of your image you can choose to “loose” some details in return for a lower file size. Alternately, if you plan to print an item and need all details you can save everything at the cost of a much higher file size. 
TIFF’s are primarily used in Desktop Printing so we will not spend much time discussing them. They are large files that support virtually any color mode and store large amounts of details. Naturally the files are generally very large.
PNG is a raster or vector based file type that is the default file type for Macromedia’s Fireworks application. Its flexibility allows it to be great for print use. Unfortunately is not supported on older versions of some web browsers, so depending on your audience you may want to avoid using it.

Of these, only PSD is guaranteed to hold all your file information properly for use in Photoshop. This file type will retain layers and text information in their original form and can therefore be changed and edited when opened later. Other file types will flatten the image and eliminate the ability to edit layers.

Save for the Web

Sometimes knowing how to save a file can be tricky, especially when you want it to go on the web. As you may have noticed, sometimes when saving image files, the output will be fuzzy or grainy. To help with this, Photoshop created the “Save for Web” option under the ‘File- Save’ menu. You can adjust the type of file you want to save it as, change the desired size (smaller, medium, large), and preview the final output to see if it appears grainy or of good quality.

Raster vs. Vector Graphics

Graphics come in two basic forms: “Vector” and “Raster”. 

Vector graphics are composed of mathematically defined shapes and lines. Vectors work with magnitude and direction and based on these details, an image is created. Because Vector objects are mathematically created, scaling the images simply requires the modification of the mathematical information within the image, and thus vector graphics can be enlarged or shrunk without losing the continuity of the image. On the down side, photographic images cannot be stored well in this format and vector formats can be difficult to share cross- platform.

Raster graphics are created of pixels. The best way to describe this is to think of a grid. A pixel is each square of the grid. In order to create and image, each pixel is fixed with its own color and on a large scale the colors for a shape or image. This is a far simpler format and tends to create images with smaller file sizes that work well under any system. The do not scale well however, as enlarging or shrinking the images causes it to lose detail or even begin to look boxy.

To view the differences between these types of graphics on a web page, please go to: http://www4.ncsu.edu/~jmriehle/training/web_images.html

Pen Tool

As mentioned at the beginning of this documentation, Photoshop is primarily created for use with photos. That being said, it does offer means by which you can create vector based objects. Text shapes and lines are all vector based in Photoshop and in the case that you need to free-hand draw with a vector tool, Photoshop offers the Pen Tool.

In order to use this you will select the pen tool, and then click once on a blank document to create a point. If you move your mouse and click again to create another point, the new point and previous point will be connected by a line. Each point you create is called and anchor point and can by used to define the line or shape. You can continue adding points that will be connected by this line until you go 360 degrees and connect to the original point, or, if you never click back on the original point, your line can go on indifferently.

	In case you want a shape with curves, rather than a line you will need to use the “Convert Point” tool. This is a tool in the submenu of the pen tool. Once selected, click on one of the anchor points and drag away in any direction. You will see the line move into a curve based on the direction and distance you pull away from the line. If you cannot find the anchor points, or have trouble selecting them, use the Selection tool (which appears right above the pen tool) to view and grab individual points.

The line that extends from the anchor point indicates the amount and direction of the curve. You can adjust both by clicking on the points at either edge of the line and dragging the curve into the appearance you desire.
	[image: image36.png]





The “Freeform Pen” tool will allow you to draw, just as you would with the paint brush, but it will make the line a vector object that you can come back and edit the points of as needed.

Using the “Convert Point”, “Freeform” pen tool and other tools available under the pen tool menu, you will be able to completely change and adjust the shape or line that you have created. A word of warning: this is a tool that takes plenty of practice to get comfortable with. Don’t get frustrated if it doesn’t work the way you want it to right away. Keep trying to put together simple objects and your skills will improve.
Photoshop Preferences

Rulers and Guides

You can get help with page layout and design by using the Photoshop ruler and guides. These are available by going to View-Rulers or View-Guides. In addition, for precise work, you may want to turn on the Photoshop grid, available under View-Show-Grid. This can also help with precise layout and along with the “Snap” option (also under the View menu) you can help yourself to align your drawings and objects correctly.

Settings

To get more out of Photoshop, advanced users may want to modify their settings in Photoshop Preferences. This menu is located under “Edit-Preferences-General”. Among other things you can choose shortcut keys, default settings including screen and print resolution, brush and cursor appearances, ruler and guide settings and more.
Cool Tools in Photoshop

Pattern Maker
The Pattern Maker tool is in the Filters menu. It will take a selected piece of an image and repeat it in a specified size to create a background image. The nice thing about this tool is that you can “generate” the background image as many times as you would like if you do not like the first representation that Photoshop come up with.

Please open the ‘Photoshop’ folder. Select ‘flag.jpg ’.

Use any selection tool (but preferably the Rectangular Marquee tool) to select an area on the picture. 

Choose Filters-Pattern Maker. The selected area will be displayed in the pop-up window. You can move it, but not resize it. Click “Generate” to get a background design. Feel free to play with other options and click Generate again to get a new design each time.

Web Photo Gallery (review from Photoshop I)
The web photo gallery is essentially a batch process that runs an action in which your folder of pictures are prepared and saved for the web. Before you can run this tool you need to make sure that all the photos you want to go on the web page are saved in one folder, with no other files in it.



Go to File- Automate- Web Photo Gallery. 

Select a Style (a thumbnail of the design is on the right). Enter your e-mail address under ‘E-mail’. Under ‘Folders’ click ‘browse’ and browse to the ‘Rafting’ folder in the file on your desktop. Click ‘Destination’ and select the folder on your desktop. Fill in the information under ‘Options’ for your Banner title, font, photo information and other details. Click ‘Ok’.
We hope that you have learned a great deal of useful information about Photoshop. If you have any additional questions not covered in this handout or in our classes please feel free to email you instructors. You may also want to consider using Adobe’s website (http://www.adobe.com/products/photoshop/main.html) for tips and tricks, and for information on the latest version.

Good luck and happy designing!
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